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EXECUTIVE SUMMARY 

The tasks performed in Activity 3.6 named “Integration of VEW in CPAs” and lead by CNIG-IGN, 
SCP and GOBCAN, are reported in this document, which represents the sixth official deliverable 
of WP3 “Early Warning System for Volcanic Activity”. The main goal of this activity is to give CPAs 
the guidelines to integrate the products resulting from the Volcanic Early Warning System (VEW) 
into their workflows. These products, which integrate Sentinel 1 and GNSS data, are defined in 
D3.1 and D.3.4, and have been generated in D3.5. Furthermore, these products have been 
validated according to the procedure described in D.3.8.  
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1 INTRODUCTION. 

In Spain, as it was explained in D3.1, the responsibility and decision-making related to the 

volcanic risk management is shared between National and Canary Island (Autonomic) authorities, 

depending on the phase and situation of the declared emergency. Different emergency plans can 

be activated, from local to national level, depending on the increasing volcanic risk and situation. 

In this framework, IGN declares the scientific alert with its own data or evaluating the available 

data forma other institutions through the scientific committee of the corresponding Emergency 

Plan. Products obtained in WP3 can be useful in the evaluation and management not only of 

Volcanic Risk Emergencies but also in Risks Emergencies in general. 

The main goal of this deliverable is to provide guidelines addressed to Civil Protection prevention 

departments to properly integrate, use and interpret the products obtained in WP3 as a support 

to early warning system for volcanic hazards. 

This document is organized as follows: Section 2 describes the different products obtained in 

WP3. Section 3 is divided into two subsections, section 3.1 gives the guidelines for the 

visualization of the products described in section 2 as well as other information of interest, and 

section 3.2 constitutes a guide for the interpretation of these products, including an application to 

a real case. Section 4 discuss contributions of the project to the Early Warning System developed 

by IGN and those that are expected to be produced in the future. 

2 DESCRIPTION OF VEW PRODUCTS. 

Products obtained in WP3 have been widely described in D3.4 and D3.5. In this document we 

only want to give a brief explanation on each of them. These products are the following ones: DIM 

(Displacement Map), DAM (Deformation Activity Maps) and ADA (Active Deformation Areas). 

When we added GPS data for these products, VEW-DIM, VEW-DAM and VEW-ADA are 

obtained. 

The DIM map is a deformation map which displays relative deformation (in mm) between two 

dates, estimated in the satellite line of sight direction. It is obtained after the phase unwrapping of 

the interferograms, and the transformation from phase to displacement. As it is explained in D3.5, 

each interferogram is separated in High Frequency (HF) component and Low Frequency (LF) 

component. Both components are processed separately, in order to produce different 

products(see Figure 2-1). HF-DIM maps are the input product for the direct integration 

methodology, and only contains points selected for the direct integration processing as it is 

explained in D3.5. HF-DIM maps can be visualized as the difference between two consecutives 

dates in DAM map. The analysis of LF-DIM maps is more qualitative due to they usually contain 

deformation but also atmospheric artifacts. This analysis must be done by experts, and if it is 

possible, integrating DIM maps with measurements coming from other geodetic or geophysical 

techniques. 
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Figure 2-1 DIM products: complete interferogram (Left), HF (Centre), LF (Right). 
 

The DAM map provides for each point, the temporal evolution of the phase with respect the first 

acquisition time and the mean LOS velocity (see Figure 2-2). The DAM map is the output of the 

direct integration and is obtained from de HF-DIM products. 

The ADA map is derived from the DAM map and it shows the ADAs, groups of measured points 

(more than five) with same deformation behaviour whose temporal series have reliable noise 

(Barra et al., 2017) (see Figure 2-3). ADA map is a useful tool that eases the DAM map analysis, 

and both of them represents an excellent starting point to recognize long-term processes. 

 

Figure 2-2 DAM map over Teide Area (Tenerife Island). 
 



 
 

U-Geohaz D3.6:  Guidelens for the Integration of VEW in CPAs                                       Page 8/23 

 

Figure 2-3 ADA Map over El Hierro Island. 
 

As it was explained in D3.4, the main objective of VEW is the creation of products that integrate 

deformation from different techniques to have a broader vision of the deformation field. In this 

project we have integrate DIM, DAM and ADA with GPS data coming from the daily processing 

of the GPS network that IGN has in Canary Islands. For this integration it is necessary to project 

GPS date to LOS, in order to be able to compare with InSAR data. As it is explained in D3.8 the 

projection to LOS is done applying the equation (Hanssen, 2001): 

𝑑𝑑𝑟𝑟 = 𝑑𝑑𝑢𝑢(cos(𝜃𝜃𝑖𝑖𝑖𝑖𝑖𝑖) − sin (𝜃𝜃𝑖𝑖𝑖𝑖𝑖𝑖) �𝑑𝑑𝑛𝑛 cos �𝛼𝛼ℎ −
3𝜋𝜋
2
� + 𝑑𝑑𝑒𝑒sin (𝛼𝛼ℎ −

3𝜋𝜋
2

)� 

According to the Sentinel-1 ascending orbits used in this analysis, these parameters are: 

- 𝑑𝑑𝑟𝑟 : deformation vector in LOS direction  

- 𝑑𝑑𝑛𝑛,𝑑𝑑𝑒𝑒 ,𝑑𝑑𝑢𝑢: deformation vectors in north, east and up directions coming from GNSS-NEU 

time series  

- 𝜃𝜃𝑖𝑖𝑖𝑖𝑖𝑖 : incidence angle for the area of interest (between 27.º53 and 44º28, depending on 

the island)  

- 𝛼𝛼ℎ  : orbit heading  (~12.5º)  
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Figure 2-4 GNSS permanent networks in Canary Islands. 
The products previously described are provided in shape files, and where appropriate, must be 

accompanied by a report performed by experts. The structure of the shape files is collected in the 

following tables. 

The DIM shape file fields are: 

Field  Description  Units  

E UTM East [m] 

N UTM North [m] 

Lambda WGS84 Geographic Longitude [º] 

Fi WGS84 Geographic Latitude [º] 

Defo Averaged deformation of the last 4 dates [mm] 

Table 2-1 DIM shapefile attributes. 
The DAM shape file fields are: 

Field  Description  Units  

E UTM East [m] 

N UTM North [m] 

Lambda WGS84 Geographic Longitude [º] 

Fi WGS84 Geographic Latitude [º] 

ADA_ID ADA id. Containing the point [-1 if it is not active point] - 

Velocity Point displacement velocity [mm/year] 

Def_mean Averaged deformation of the last 4 dates [mm] 

Daaammdd Deformation value at date aaaa/mm/dd [mm] 

Table 2-2 DAM shapefile attributes. 
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The ADA shape file fields are: 

Field  Description  Units  

ADA_ID Identity of the Active Deformation Area - 

N_APS Number of active points in the ADA - 

X_MEAN UTM East [m] 

Y_MEAN UTM North [m] 

VEL_MIN Minimum measured velocity [mm/year] 

VEL_MEAN Averaged measured velocity [mm/year] 

VEL_MAX Maximum measured velocity [mm/year] 

VEL_CLASS Class of the ADA 
1 if VEL_MAX > 
20 mm/yr; 0 
otherwise 

DEF_MEAN Averaged deformation of the last 4 dates [mm] 

TNI_CLASS Temporal noise index - 

SNI_CLASS Spatial Noise index - 

QI_CLASS Quality Index of estimated velocity - 

Table 2-3 ADA shapefile attributes. 
 

The GPS data shape file fields are: 

Field  Description  Units  

COD_GPS Code of GPS station in the IGN Network  

E UTM East [m] 

N UTM North [m] 

Lambda WGS84 Geographic Longitude [º] 

Fi WGS84 Geographic Latitude [º] 

ADA_ID ADA id. Containing the point [-1 if it is not active point] - 

Velocity Point displacement velocity [mm/year] 

Std_dev_gps Standard Deviation of the gps serie [mm] 

Def_mean Averaged deformation of the last 4 dates [mm] 

Daaammdd Deformation value at date aaa/mm/dd [mm] 

Table 2-2 VEW-DAM shapefile attributes. 
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3 INTEGRATION OF VEW PRODUCTS. 

3.1 Visualization. 

In order to analyse and integrate the previously cited products into workflows it is essential to be 

able to visualize them.  

In section 3.1, it is briefly exposed how to visualize them in QGIS (an opensource GIS software) 

and in Google Earth Pro. In section 3.2, it is exposed how to load Web Map Services (WMS) in 

both softwares in order to have available basic geographic information (towns, infraestructures, 

etc) useful for the interpretation of products and for crisis management.   

3.1.1 Visualization of WP3 products. 

3.1.1.1 QGIS. 

In QGIS, depending on the data format, there are different tools that allow to visualize the 

products, mainly available in the Layer → Add Layer → menu or from the Manage Layers toolbar 

(enabled through View → Toolbars menu). In our case all the products are vector layers, so we 

are going to use the option Add Vector Layer. 

Another way to add a layer into a project is to use the Browser interface, following these steps: 

1. Find the layer in the list. 

2. Double-click its name or drag-and-drop it into the map canvas. Your layer is now added to the  

Layers panel and can be viewed in the map canvas. 

In order to customize data visualization, the use of the Layer Properties dialog is useful. This 

dialog provides for a vector layer general settings to manage appearance of layer features in the 

map (symbology, labeling, diagrams), interaction with the mouse (actions, map tips, form design). 

It also provides information about the layer. 

To access the Layer Properties dialog: 

• Option 1: In the Layers panel, double-click the layer or right-click and select Properties from the 

pop-up menu; 

• Option 2: Go to Layer→ Properties menu when the layer is selected. 

We recommend consulting the QGIS information available in QGIS1 and QGIS2 to have a better 

knowledge of these tools. 

3.1.1.2 PS Time Series Viewer Plugin. 

QGIS plugins add additional functionality to the QGIS application. There is a collection of plugins 

ready to be used, available to download in different websites. These plugins can also be installed 

directly from the QGIS Plugin Manager within the QGIS application. 

 

https://docs.qgis.org/3.4/en/docs/index.html
https://docs.qgis.org/3.4/en/docs/training_manual/index.html
https://plugins.qgis.org/plugins/
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Figure 3-1 Example of the output or PS Time Series Viewer for a measured point from de 
DAM. 

To install or activate a plugin, go to Plugins menu and select Manage and install plugins. The tabs 

in the Plugins dialog allow the user to install, uninstall and upgrade plugins in different ways. Each 

plugin has some metadata displayed in the right panel: 

At the top of the dialog, a Search function helps you find any plugin using metadata information 

(author, name, description…). 

In this case the plugin we recommend to use is “PS Time Viewer Series”.  Once you have installed 

it, an icon appears in the manager toolbar. To use it, click the icon of the plugin, select in the 

Layers panel the layer you want to get information about, and click in the map over one of the 

points of the layer. This plugin is very useful to interpret the DAM map because the output is the 

evolution of this point during the time, since the reference date. Next picture shows an example 

of the plugin’s output. 

3.1.1.3 Google Earth Pro. 

Another other widely used software that allows to visualize shape files is Google Earth. To load a 
shape file in Google Earth Pro, follow the next steps: 

1. File -> Import -> Select ESRI shape and point the shape file to be loaded. The corresponding 

.prj file must be present. If your file contains more than 2500 features, a warning message 

appear, asking you if you want to import a sample of the data, restrict the imported data to 

your current view, or to import all.   

2. After that, a message will be prompted to create a Style Template. If you want to personalize 

the style of your data (what we recommend you), click Yes. In the Style Template Settings 

dialog box, you can create a style template including colors, labels, and icons. You will be 

prompted to save the style template for future use. 
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By default, the layer loaded is not activated. To display the layer, check the corresponding box in 

the legend. You also can enable or disable the different background and other information layers. 

Clicking on the different features information of the attribute table will be appear.  

More information about how to import a shapefile to Google Earth is available in Google Earth. 

3.1.1.4 Grafcan Viewer. 

Grafcan viewer (https://visor.grafcan.es/visorweb/) allows to load shapefiles and kml files, with 

the limitation of 3Mb of size. This is an important limitation for U-Geohaz products. Only ADA and 

VEW (GPS) products can be load in this viewer. To load layers, click on layers’ menu on the right 

side of the viewer. Clicking on the feature and selecting “Properties of the feature” information of 

the attribute table will be appear. The shapefiles format required is a zip file containing .shp, .shx 

and .dbf files. 

3.1.2 Other geographic information (WMS). 

Information of different types and sources can facilitate interpretation and increase the usefulness 

of the products of this project. Usually this information is produced and made available for the 

user by a lot of different organizations. Web services can facilitate access to that information. 

A Web Mapping Service (WMS) is a map service hosted on a remote server. We are going to 

explain how to load a WMS in QGIS. 

To load a WMS the procedure is similar to loading a vector file (explained in 3.1.1.1) but selecting 

Add WMS/WTS layer.  

To create a new connection to a WMS, click on the New button.  

A name and the URL of the WMS service must to be entered in the corresponding fields.  

Click connect and select the layer or layers you want to add. Click add button and the layer will 

be appeared in your Layers Panel. 

3.2 Interpretation. 

Products delivered in this project have been defined in section 2. Section 3.1 provides some 

guidelines to open and visualize them together with other outstanding information layers which 

can help in the interpretation. 

In this section we propose some guidelines aimed to recognize and analyse possible deformation 

areas by analysing ADA, DAM and GPS products generated in the project. Finally and following 

suggestions proposed in this document, we conclude with the evaluation of possible hazards in a 

real case which took place in Tenerife Island during June 2017.  

3.2.1 ADA analysis  

ADA map is generated from DAM following strict criteria aimed to highlight areas that show 

reliable displacements with time (Barra et al., 2017). So, in case local deformations exist during 

the study period, they should be included in the ADA map as long as their velocities are above 

stablished thresholds for every island (see D3.5). Therefore, in order to evaluate possible defor- 

https://www.google.com/earth/outreach/learn/importing-geographic-information-systems-gis-data-in-google-earth/
https://visor.grafcan.es/visorweb/
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Figure 3-2 ADA selection around Teide-Pico Viejo. 

mation signals, the first product to be inspected is ADA map. To help the interpretation we 

recommend ADA map to be displayed over a DEM, ortoimage or street map service as it has 

been explained in section 3.1.2. 

By identifying the spatial object we can access to ADA attributes, in particular to VEL_MEAN and 

QI_CLASS which are averaged velocity and quality of ADA respectively. QI_CLASS considered 

reliable enough are numbered 1 and 2, whereas 3 and 4 need extra revision (Barra et al., 2017). 

On the other hand, VEL_MEAN provides magnitude of the velocity. However, to characterize the 

deformation and possible effects, it is important to know the direction of displacement for the 

purpose of risk management; in other words to know the sign of the velocity. For example a 

subsidence, which main part of the movement is downwards, would be translated in a negative 

velocity. On the contrary, an upward movement would have a positive velocity. This information 

is not included directly in ADA attributes but it is in the DAM map used to generate the ADA. So 

to interpret ADA properly it is necessary to analyse DAM.  

DAM map contains all MP (measured points) which have been selected by the methodology 

regardless their standard deviation. To ease the analysis of ADA we recommend to filter out MP 

whose two times standard deviation is between the thresholds established for every island as 

these points are considered too noisy (see D3.5). Those thresholds are:  

- Tenerife: 8.2 mm/year 

- El Hierro: 11. 2 mm/year 

- La Palma: 13.7 mm/year 
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To simplify the analysis further, and taking into account that the direction of movement can be 

decisive to risk management, we also recommend to separate positive and negative trends. In 

this way we have separate DAM map in positive and negative displacements that contain only 

reliable MP. 

Once DAM is properly filtered, it can be displayed together with ADA. This way it is easy to know 

the ADA direction of movement as most of MP inside an ADA should have similar trends. 

Moreover, it can be useful to check temporal time series of MP inside the ADA, making use of ps 

time series viewer tool (see section 3.1.1). For example, if we want to know if a phenomenon 

which took place in a certain date have had an effect on deformation for a certain area, it can be 

checked in the time series.  

 

 

Figure 3-3 Selection of MP with velocities over 8.2 mm/year in Teide-Pico Viejo. Red MP show 

positive trends, blue ones show the opposite. 
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Figure 3-4 MP inside ADA located in Guajara Mountain, inside Parque Nacional del Teide. Color 

codes are the same as in Figure 3-3. 

 

Figure 3-5 Time Series of a MP inside positive ADA from Figure 3-4. 
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Figure 3-6 Time Series of a MP inside negative ADA from Figure 3-4. 

3.2.2 DAM analysis 

We can also be interested in a certain area which is not an ADA. This situation demand direct 

DAM analysis. For example, it is possible that there are areas with movements under the selected 

threshold which would not constitute an ADA but even so, we can be interested in. It is also likely 

that there are several MP with meaningful velocities, however they do not fulfil the vicinity 

conditions to be an ADA.  

In those cases we can open DAM map, filtered by direction of movement would be advisable, and 

apply a colour scale based on velocity. We likely see clusters of points with a spatial pattern, if 

they exist. We can also query the MP time series with ps time series viewer.   

 

Figure 3-7 DAM represented with a color scale (same codification as previous images) around 

Teide-PicoViejo 
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3.2.3 DIM analysis 

According to the description done in section 2, DIM-HF products are transformed to DAM through 

direct integration methodology. 

As far as DIM-LF is concerned, as it contains both deformation and atmospheric signals, the 

analysis is quite complex. Best recommendation in this case is to be advised by an expert to 

interpret possible deformations.   

3.2.4 GPS analysis 

DAM and ADA maps are the result of applying InSAR techniques, however products provided in 

this deliverable also include GPS time series. GPS results are referred to the location where the 

equipment is installed, so its spatial coverage is punctual, but the precision of the measurement 

is generally better than achieved by InSAR techniques. Then, we can consider GPS time series 

as a very precise recording of a point movement. This fact is useful in several senses when trying 

to interpret ADA or DAM products. For example, in case there are several MP inside an ADA with 

different trend, so the behaviour of the entire ADA it is not clear, GPS direction of movement can 

be decisive to point out the real trend. Analogous situation can take place in case we are analysing 

areas of DAM not included in ADA map.  

 

 

Figure 3-8 TN03 GNSS time series projected to LOS 

 

3.2.5 Application to a real case: Volcanic Early Warning System products interpretation 
during a seismic swarm in Tenerife island.  

In the last years tens of volcanic alerts have been declared in The Canary Islands always 

accompanied by anomalous seismicity and sometimes by other geophysical parameters, as they 

are deformation and geochemical signals.  
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In this section we want to show the way U-Geohaz products are interpreted, together with other 

data coming from IGN networks to declare and track volcanic alerts, as well as evidence the 

added-value of these products for the volcanic early warning system. 

IGN is the institution in charge of generating volcanic alerts to Civil Protection Authorities in Spain 

(RD 953/2018). Continuously, we analyse data coming from geophysical networks stablished in 

active volcanic areas. This allow us to detect anomalous activity and characterize it, being also 

able of stablish its evolution. The ability of interpreting volcanic activity from different techniques 

is essential to characterize the event.  

During 2017 a singular episode took place in Tenerife island. Seismic networks detected twelve 

low magnitude swarms in the vicinity of Teide volcano between 7-19 km depth 

(https://www.ign.es/web/resources/volcanologia/pdf/20170609_Tenerife_IGN.pdf) Commonly, 

seismicity is the technique which warns the other parts of volcanic system about the existence of 

anomalous activity. However deformation is a fundamental parameter to stablish changes in the 

volcanic system related with a possible pressure increase. U-Geohaz products are based in GPS 

and InSAR techniques which provide DIM, DAM and ADA, so the information derived from them 

is valuable to stablish a volcanic alert. To show the importance of U-Geohaz products to the 

system we are going to analyse the way we would have interpreted the deformation contained in 

the maps during the mentioned episodes on 9 June 2017. 

 

Figure 3-9 Location of 9 June 2017 events  

https://www.ign.es/web/resources/volcanologia/pdf/20170609_Tenerife_IGN.pdf
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Events were located inside Parque Nacional del Teide, west of Teide-Pico Viejo volcanic complex. 

Although in this case depth and magnitude of seismicity did not pointed out to a detectable source 

of deformation its existence could not be rejected. So, the kind of signals we are looking for are 

positive in DAM, ADA and GPS, consistent with an overpressure source. DIM could also provide 

information, although its interpretation is be more complex. To provide an evaluation to Civil 

Protection Authorities, we propose the following actions: 

- ADA map general inspection in the surrounding of Teide-Pico Viejo complex:  

 

 

Figure 3-10 Selection of ADA in Teide-Pico Viejo area 

 
We conclude that there are some ADAS, close to seismicity, which deserve further analysis 

 

- Analysis of DAM with positive trends inside the ADA close to epicentres:  We filter DAM 

map to select points above the fixed threshold only with positive trends, which could be involved 

with a change pressure.  

Once we have selected ADA with positive trends above 8.2 mm/year, we analyse the time series 

of the MP inside to check if there are changes around 9 June 2017. 
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Figure 3-11 MP showing positive trends inside DAM in the area of study. 
 
 
 

 

 
 

Figure 3-12 Time series of a MP inside ADA_ID number 9, located a few kilometres to the 

epicentres 

 
Results do not show meaningful changes in deformation related to the swarm (see Figure 3-12). 

Slope variation which takes place on March 2018 seems to be related to other causes.  
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- Detailed DAM analysis in Teide-Pico Viejo: Although ADA do not show deformation 

changes related to the swarm, a good practice is to analyse the complete DAM, filtered to show 

only positive trends, as the expected deformation can be difficult to observe and close to the 

background noise.  

 

 

Figure 3-13 DAM positive velocities around Teide-Pico Viejo 

 
Results do not show clusters of points with velocities close to the active thresholds that can be 

interpreted as low magnitude deformation areas.  

 

- Interpretation of DIM-LF: In case a volcanic source exists, its expected deformation can be 

larger than several squared kilometres which mean that the signal would not appear neither DAM 

nor ADA but in DIM-LF. However, as DIM-LF contain possible deformation and atmospheric 

effects, the last cannot be removed properly with the current methodology, so only a partial and 

qualitative interpretation could be done.  

 

- GPS time series analysis: We would check GPS time series in a similar way we have 

inspected DAM time series. Relevant difference between GPS and derived InSAR time series is 

precision which means that GPS could see changes that DAM time series could not.  
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Figure 3-14 TN08 GNSS time series projected to LOS 

 

Analysis conclude that there is no deformation related to the swarm in the GPS stations of the 

area. 

Similar analysis of other geophysical parameters (gravimetry, gas and water analysis) did not 

point to a volcanic intrusion.  

With this analysis we would conclude that the registered swarm was not accompanied by 

deformation or geochemical changes in the volcanic system, so the scientific alert level would 

remain low.  

3.3 VEW-DAM Web Map Service. 

One aspect that is currently being worked on is the possibility of generating WMS services to 

make some of the products in this workpackage available. The CNIG is the organization that 

manages the Spanish SDI, and the possibility of generating these WMS with them has already 

been discussed. The availability for the generation of this service is total and will be subject to an 

analysis of the possibilities offered by the products at the end of the project and the utility that the 

services may have for the different partners. 
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